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C h a p t e r  7

 

M a c - t o - W i n d o w s
B a n k  C o n v e r t e r

 

The Mac-to-Windows Bank Converter is designed to assist users and
bank providers in migrating LXR•TEST 5.0 and 5.1 Macintosh ques-
tion banks to Windows.  LXR•TEST for Macintosh has been around
for many years (since 1986 to be exact), and there exists a large num-
ber of banks for the Mac.  These Mac banks are a valuable source of
content for Windows users.  Although the Converter currently sup-
ports migration only from the Mac to Windows, it is envisioned that
future versions LXR•TEST may support bi-directional bank conver-
sion—or require no separate conversion at all.

This Bank Converter chapter is organized in four sections: 

 

Installation

 

  instructions on installing and setting up the software.

 

Overview

 

  general information about the conversion process.

 

Tutorial

 

  step-by-step guide to building an interactive test and extract-
ing scoring data.

 

Reference

 

  a quick access to the commands and features.

 

Installation

 

System Requirements

 

  The 

 

Mac-to-Windows Bank Converter

 

 is
designed to operate on any IBM/Compatible PC that is supported by
LXR•TEST 5.0 or 5.1 for Windows.

 

Installing the Software

 

  The  Mac-to-Windows Bank Converter is
stored in a compressed format on a separate Converter disk.  During
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the installation, the files are expanded and copied to your hard drive.
Approximately 1 megabytes of disk storage is required.  

 

Note

 

:

 

LXR•TEST must be installed prior to installing the Converter.
The converter then must be installed in the same directory as
your LXR•TEST program.  The default directory is C:\LXRT-
EST.  If you have placed your LXR•TEST program elsewhere,
you will need to install the Converter in that same directory.

 

1. Start Windows as you normally would. 

2. Insert the Program Disk into your disk drive.  Within the Windows 
Program Manager, 

 

choose

 

 

 

Run

 

... from the File menu.  Enter 
“B:SETUP” in the Command Line box.  

 

Click 

 

OK

 

.  (Substitute 
“A:SETUP” if you are installing from your A: drive.)

3. Follow the instructions presented in the setup dialogs and press Con-
tinue to proceed with the installation.  When finished, you will 

 

click

 

 

 

OK

 

 to return to Windows.  (The setup program creates a logfile.out 
file that indicates the location of each file placed on your system.)

 

Overview

 

Why Conversion in the First Place? 

 

  Although the 

 

overall

 

 structure
of question banks (where and how things are stored) are identical
between Mac and Windows, there some 

 

detail

 

 differences.  Most of
these are due to inherent differences between the two operating envi-
ronments.  For example, on a Macintosh, a “PICT” type graphic may
be stored at a certain location in a question.  Since the Windows oper-
ating system does not recognize a “PICT” type graphic (rather it has
its own graphic types), these graphics need to be converted so they
can be displayed and printed.  Also, text fonts, tabs and rulers are han-
dled somewhat differently between the two systems.  The Converter
is designed to resolve such differences as much as possible and make
the necessary question bank changes for use with LXR•TEST for
Windows.

 

Note: LXR•TEST/Mac 5.0 and 5.1 score, student lookup and grading
table files require NO conversion.  These files may be moved
from Mac to Windows and directly used by LXR•TEST/Win-
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dows.

 

LXR•TEST Question Bank Files

 

   The question bank files them-
selves can be moved directly from the Mac to your Windows com-
puter—either by disk or over a network.  The Converter operates
directly on the existing Mac file.  The only requirement is that the
Mac question bank must be in LXR•TEST 5.0 or later format.

 

Text Conversion

 

   The Converter performs all the necessary transla-
tion of fonts, sizes, styles, rulers and tabs for all question text.  If the
Mac bank you are converting uses the standard set of TrueType fonts
that come with a Mac system, the TrueType fonts that come with your
Windows 3.1 should be sufficient.  However, if specialized fonts were
used in the Mac bank, then these typefaces would need to be available
for Windows.  Alternatively, you may need to instruct the Converter
to substitute a different Windows font for the Mac font.  Font substi-
tution is discussed in detail in the reference section.  

 

Graphics Conversion

 

     If the Mac bank you are converting has any

 

graphics

 

, you have several choices to consider.  You may choose to
use the built-in graphics conversion software which is integrated with
the Converter or you may use one or more third-party graphics con-
version software tools which directly interface with the Converter.

 

Note: If your graphics exist  in a TIFF format within your Mac question
banks, no conversion is necessary from Mac to Windows under
version 5.1.

 

The graphics issue primarily is one of getting Mac PICT graphics to a
graphic format supported by Windows.  The PICT graphics format is
really a “meta-format”—that is, it can contain both ‘bitmap” and
“object” images.  Bitmap and object graphics are sometimes referred
to as “raster” and “vector.”  Basically a bitmap image is one that con-
sists of a series of “dots” (generated by “paint” programs).  An object
image is one that is represented algebraically (generated by “draw-
ing” programs).  Why do you care?  You may care because some third
party graphics conversion tools may operate better with one graphic
type than with another.  You may also care because the quality and
size of your images can vary dramatically depending on the type of
graphics that are being converted and method of conversion being
used.  
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Built-in Graphics Conversion

 

  The Converter includes built-in soft-
ware (Accusoft

 



 

) that will convert LXR•TEST 

 

bitmap

 

 PICT graph-
ics to Windows-compatible DIB (Device Independent 

 

Bitmap

 

)
graphics.  It will not convert object PICT graphics.  Since you may
not know whether the Mac PICT graphics are in bitmap or object for-
mat, we introduced an LXR•TEST/Mac export option to convert all
graphics to a bitmap format which can be accommodated by the Con-
verter.  This export (bitmap) option is available only with a
LXR•TEST/Mac 5.0.8 or later revision.  If you use the export bitmap
option, you will have a choice of 72, 144 or 300 dots per inch resolu-
tion.  A higher resolution setting will provide greater graphic detail
but consume more disk space (e.g. result in larger question bank
files).   

LXR•TEST 5.0.8/Mac Export Dialog

The Converter also has the option to extract each graphic and copy it
as a separate file into a picture directory (

 

bank.pf

 

) where “

 

bank

 

” is the
name of the Windows bank.  The Converter will place graphic mark-
ers in the question edit boxes to identify the number of the picture that
needs to be converted and pasted.  For example, the first picture file
will be named “PICT001.PCT” and the number “001” will be placed

Sets image resolution when converting
pictures to bitmaps (exporting to use under
Windows)

Converts non
equation graphics
to bitmap(exporting
to use under
Windows)

Check only when
using the built-in
(Accusoft) graphics
converter

Do NOT check if using
MathType on Windows
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in a picture frame in each item.   If you choose to convert these graph-
ics later, you will need to convert these Mac PICT images and manu-
ally repaste them in the new Windows question bank at the proper
locations. 

 

Third-Party Graphics Conversion

 

   The Converter also currently
interfaces to three different third-party products which perform
graphics translation:  Graphic Tools!

 



 

, ImagePals

 



 

 and HiJaak

 



 

.
LXR•TEST supports three primary graphic formats under Windows:
TIFF, DIB and WMF (Windows Meta-File).  Only the WMF format
provides a true 

 

object

 

 graphic format (similar to PICT on the Mac).
For some graphics the WMF format provides both superior quality
and reduced graphic sizes.

The following table provides additional information on supported
graphic conversion tools:
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Note: LXR has chosen leading graphic conversion vendors to provide
the best possible translation of your Mac graphics to windows-
compatible graphics.  However, the results of graphics transla-
tion will vary depending on your specific graphics and the

 

Product Contact Notes

Accusoft

 

TM

 

Logic eXtension 
Resources
Voice: (909) 980-0046

 

Fax: (909) 987-8706

 

• Built-in to the Converter (no additional 
purchase required).

• Converts 

 

bitmap

 

 PICTs to 

 

DIB

 

.
(LXR Note: Fast, accurate conversion of 

 

bitmap

 

 (only) PICTs to 

 

DIB

 

.  Requires that 
Mac bank be exported as “bitmap” using 
LXR•TEST/Mac 5.0.8 or later.)

 

Graphic 
Tools!

 



 

DeltaPoint
Voice: (408) 375-4700

 

Fax: (408) 648-4000

 

• Must be purchased and installed sepa-
rately.

• Converts 

 

both bitmap and object

 

 PICT for-
mats to 

 

WMF

 

.
(LXR Note: This is the only product that 
currently offers direct conversion of 

 

all

 

 
PICTs to the 

 

WMF

 

 (object) format.  Excel-
lent graphic conversion fidelity, small bank 
sizes, good conversion speed.)

 

ImagePals

 



 

U-Lead Systems, Inc.
Voice: (310) 523-9393

 

Fax: (310) 523-9399

 

• Must be purchased and installed sepa-
rately.

• Converts 

 

both bitmap and object

 

 PICT for-
mats to 

 

DIB

 

.
(LXR Note: Good, fast conversion of 

 

all

 

 
PICTs to 

 

DIB

 

.)

 

HiJaak

 



 

Inset Systems
Voice: (203) 740-2400

 

Fax: (203) 775-5634

• M

 

ust be purchased and installed sepa-
rately.

• Converts 

 

both bitmap and object

 

 PICT for-
mats to 

 

DIB

 

.
LXR Note: The traditional DOS and Win-
dows graphic conversion tool.  Somewhat 
slower than others.
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graphics conversion program you’ve selected.  Regardless of
the fidelity of the conversion, you will need to review—and
likely edit—some of the graphics after the conversion.  If you
have specific feedback regarding how a graphic is converted
by a third-party product, you should contact that graphics con-
version software vendor.  If you have any other questions or
suggestions regarding the Converter itself—or the Converters
built-in converter (Accusoft), you should contact LXR.

 

Equation Conversion

 

      If the Mac bank you are converting has any
equations created by MathType, you will want to also have the Math-
Type 3.0 (or later) program installed on your Windows computer.  If
the Converter finds MathType on your Windows computer—and
encounters any MathType equations during the conversion—the
Mac-based equation will be directly translated to a Windows-based
equation editable by MathType for Windows.  If MathType is not
found on your Windows machine, all equations are treated just like
any other Mac graphic.

 

Note: The LXR Converter uses the MathType server to convert Math-
Type equations in Mac format to MathType equations in Win-
dows format.  Before using the Converter, start the MT Server
and make sure the delay option is set to “Forever.”  

 

For additional information on MathType contact your LXR•TEST
dealer or: 

Design Science:  Voice: (310) 433-0685, Fax: (310) 433-6969.

 

Movie Conversion

 

       In order to use a Mac QuickTime

 



 

 movie in
Windows, the movie must have been saved in a special format before
being transferred to your Windows computer.  To do this, you will
need to run the Apple Movie Converter program on a Mac (in the
Apple QuickTime Starter Kit) and save the movie with the “

 

Make
movie self-contained

 

” radio button selected and “

 

Playable on non-
Apple computers

 

” checked.

Unlike graphics, movies are not stored directly within the item itself.
Rather, each movie is stored in a separate file.  Each item in a ques-
tion bank that contains a movie, stores a path name reference to the
external movie.  When the Converter encounters a movie reference
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within an item, it changes the reference to a subdirectory name of
“QTMOVIES” within the current bank directory.  In other words,
after conversion, LXR•TEST will expect all movies used by the bank
to be in a subdirectory called “QTMOVIES”—not anywhere else.
For example, if you have a bank in a directory called “C:\LXRT-
EST\SAMPLES”, the movies for the bank must be placed in a subdi-
rectory called “C:\LXRTEST\SAMPLES\QTMOVIES” (converter
does not place movies).

 

Tutorial

 

This tutorial will guide you through the basic process of converting a
Mac question bank file to a Windows question bank.  You need to
have access to a Mac question bank file in LXR•TEST 5.0 format to
complete this tutorial.

 

Note: There are many ways to get a Mac bank to your Windows com-
puter depending on your configuration.  For those with net-
works that connect both Macs and PCs, you simply need to
copy the bank from a Mac on your network to your PC.  If you
don’t have access to such a network, you may use Apple File
Exchange on a Mac and transfer the Mac bank to a DOS for-
matted disk.  Then take this disk to your PC.  Remember DOS
limitations in file naming conventions.  LXR•TEST uses the
“.BNK” file extension to identify its banks in Windows.

 

1. Copy a Macintosh question bank file to your PC’s hard disk.

 

Tip! If you attempt to convert the Mac file directly from your floppy disk
your conversion time will increase dramatically!  Place the bank on
your hard disk for better performance.

 

2. Confirm that you have enough disk space to create an updated copy of 
your bank.  The newly converted Windows bank will be at least as 
large as the Mac—and can be considerably larger if the bank contains 
many graphics.  Additional space will also be required for temporary 
files used by LXR•TEST and any graphic conversion programs.

3.

 

Double-click

 

 the 

 

Converter

 

 program icon.
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4.

 

Click

 

 the 

 

Mac Bank button

 

.  A standard Open file dialog will appear.  
Select the desired Mac question bank and 

 

click

 

 

 

OK

 

.  The Mac bank 
file name will appear below the panel of the left list.

5.

 

Click

 

 the 

 

Windows Bank

 

 button  .  A standard Open 

file dialog will appear.  Select a new or existing Windows question 
bank name and 

 

click

 

 

 

OK

 

.  The Windows bank file name will appear 
below the panel of the right list.  (You must open the Mac bank before 
you will be able to open a Windows bank.)

6.

 

Check

 

 the 

 

Convert All

 

 checkbox to highlight all Mac items.  If you 
only want to convert a subset of items, then highlight them individu-
ally.  

Click first to
open a Mac bank

Click second to
open a Windows
bank

Click to highlight all
items

Click to highlight
individual items

Click to convert
highlighted items

Specify graphics
conversion
software
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7. In the Graphic list box choose your preferred graphics conversion 
tool.  The first time you choose a tool, the Converter will prompt you 
for its location on your hard disk.  The chosen graphics conversion 
tool (if any) will be used for converting any Mac “PICT” graphics to 
Windows-compatible graphics.  Or, you may choose None to ignore 
pictures.  

If you activate the “File.pct graphics” checkbox, all images will be
stored as individual graphics in Mac PICT format.  They will be
placed in a “BANK.PF” subdirectory (where BANK is the name of
your Windows test bank).

8.

 

Click

 

 the 

 

Convert

 

 button  . The Converter will begin 
the translation process. 

During the conversion process, a log file is created with information
relating to the conversion.  

9.

 

Choose

 

 

 

Show Log

 

 from the File menu to review any conversion 
errors that may have been noted. 

 

Note: If your log file shows “Error cp 17. Failed to reformat question,”
you should open the newly converted bank in LXR•TEST and
perform the Reformat Question option under Global Changes
(Utilities menu).  This will automatically reflow text into the edit
boxes of each item.

 

10. Quit the Converter by 

 

choosing

 

 

 

Quit

 

 (File menu). 

After your conversion is complete, you can open your new Windows
bank with your LXR•TEST 5.0 Windows program.  Be sure and
inspect all questions that were selected by the Converter.

 

Reference

 

This Mac-to-Windows Bank Converter Reference section is designed
to facilitate your access to each of the converter’s functions
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Converter Window

 

Bank Options

 

    The 

 

Bank Options

 

 contains two options for question
conversion.  The first checkbox, Convert all, is a convenient method
of selecting all questions in the item bank, without having to click on
each question or objective individually.

 

The Overwrite duplicate checkbox instructs the Converter to over-
write any existing Windows items with identical items being trans-
ferred from the Macintosh question bank.  

Select Options   The Select Options allows you to choose three types
of conditions for selecting converted items.  If a condition you
checked occurs, a statement will be recorded in the Log file, showing

View by item
or objective

Choose
graphics
conversion
software

Open Mac bank Open Windows bank

Save each
picture as
separate file

Mac bank pathname Windows bank pathname

Perform
conversion
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the error message and its question number and the converted item will
be marked as selected in the Windows bank.

The QuickTime  Movie checkbox detects when a QuickTime movie
is embedded in a question. 

The Special Character option identifies non-transferable characters.
Certain Mac keyboard characters have no equivalent in the Windows
(such as  ).  The Log file will show the location and ASCII code of
any non-mappable characters encountered.

The Picture Failure  warns of any identifiable conversion error.

Graphic Options   The Graphic Options allows you to specify which
third party software is to be used to translate the Mac graphics (PICT)
to Windows graphics.  Choose the name in the list box of the graphics
conversion tool you want the Converter to use.  

 

If the Converter is unable to find the graphics conversion program a
dialog will be presented for you to specify the name of the directory
where the third-party graphic conversion tool is installed.

If None is highlighted, no graphic translation will take place.

Enter the directory name where the
graphic conversion tool is installed
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If you check the File.pct graphics checkbox, the Converter will save
pictures from your Mac bank to individual Mac graphic files in a
bank.pf subdirectory.  This allows you to use other graphic conver-
sion programs if so desired.

Tip! If you are unsatisfied with the quality of a converted graphic, try
using a different graphics conversion program and reconvert these
items with the Overwrite duplicate checkbox checked.

Accusoft  is the built-in graphics conversion module provided by
LXR with the Converter.  It requires that your bank be exported with
the “PICT to bitmap” option checked in LXR•TEST (Macintosh)
5.0.8 or later.

For additional information on third-party graphics conversion prod-
ucts refer to the table in the previous  section.

The File.pct graphics checkbox directs the Converter to save pictures
from your Mac bank to individual Mac graphic files in a BANK.PF
subdirectory.  This allows you to use other graphic conversion pro-
grams if so desired.

View by  This list box allows you to select questions by item or by
objective.  

 

View by Item will list each individual question sorted by question ID
(objective and sequence number).  View by Objective will list objec-
tive names only.  When selecting by objective, all questions within
that objective group will be selected and converted.
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Mac Question Bank Panel   This left panel displays all questions in
the selected Macintosh question bank, displayed by question ID or
objective.  The Mac file name is shown just below the panel.

Windows Question Bank Panel   This right panel shows all ques-
tions in the current Windows question bank.  The Windows file name
is shown just below the panel.  

Mac Bank Button     Displays a standard Windows Open
dialog box to open a Macintosh question bank.  

Tip! You can combine two or more Mac question banks into one Windows
question bank.

Windows Bank Button   Displays a standard Windows
Save As dialog box to save your converted questions to either a new
question bank or an existing Windows question bank.  A Mac ques-
tions file needs to be selected before selecting the Windows file. 

Convert Button     Converts selected Mac bank ques-
tions to the Windows question bank format.

Quit Button    Exits the program.

Items displayed individually Item displayed in objective groups
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Menus

File

The File menu represents an alternative method of performing the
same functions described previously in the Converter Window ele-
ments section.

 

Open Macintosh Bank     Opens a Mac question bank (same as Mac
Bank button).

Open Windows Bank   Opens a Windows question bank (same as
Windows Bank button).  If this option is dimmed, you need to select a
Mac questions file before selecting the Windows question bank file. 

Close All     Closes all open Converter windows.

Convert    Converts selected Mac questions to Windows format
(same as  Convert button).

Quit     Quits the Converter (same as Quit button).

Log

The Log menu provides access to the converter log file.  The con-
verter log file shows status information and errors resulting from bank
conversion attempts.
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Show Log    Displays status information for the Converter.  Such
information might include failures of picture conversions, existence
of non-mappable characters, use of QuickTime movie files and times
of conversion.   To generate some of these messages, refer to the
Selection box.  Log file information is retained until cleared out by the
Clear Log command (Log menu).

Tip! You should read  the contents of the log file after every conversion.

Hide Log    Closes the log file window.

Clear Log    Erases contents of current log file.

Save Log File...    Saves the contents of the converter log to a file.  A
standard Save As dialog box is displayed for inputting the log’s file
name.  The log is cleared after being saved.

Help    The Help menu contains information regarding program ver-
sion and date.

 

About LXR•TEST Converter   Displays various information about
the Converter.

Font Substitution Control

The Converter is preset to automatically accommodate the proper
translation of the most popular Mac fonts and characters to their cor-
responding Windows equivalents.  This “font mapping” feature is
controlled by entries in a converter text file called “LXRCONV.SET”.
You may wish to print this file to view “factory” font conversion set-
tings.  Once you understand the fundamentals of how fonts are
“mapped,” you can add or edit your own font and character substitu-
tion information in this file as desired.

Note: You should not normally need to delve into these font substitu-
tion “internals.”  This information is intended for advanced
users in special text conversion circumstances.
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Fonts Table    The Fonts Table assigns a Macintosh font to a Win-
dows font.  In the above illustration, the Mac Geneva font is to be
substituted with the Windows Arial font.  

A couple of font conversion rules apply:  

1. A Windows font of the same name as the Mac font will be used if it 
exists, unless there is an overriding entry in the Font Table.  Notice in 
the above illustration, an entry in the Font Table directs converting 
Mac Courier to Windows New Courier.  This table entry will take pre-
cedence and all Mac Courier fonts will become New Courier under 
Windows.

2. If no font is designated in the font table, the Arial font will be used.

Groups Table    The Groups Table assigns each Windows font to a
specific Character Table.  Fonts contain an array of characters each of

[Fonts]
Courier=Courier New
Geneva=Arial
. . .

[Groups]
Arial=Standard TrueType Font
Courier=Standard Bitmap Font
. . .

[Standard TrueType Font]
0x80=0xC4
0x81=0xC5
. . .

[Pictures]
C:\LXRTEST\SAMPLE.BNK=43
C:\LXRTEST\WIN.BNK=71

[Path]
C:\HJPRO\
C:\GT!\
C:\PALS\

Font table
Mac font =Windows font

Group table
Windows font = character
group exception table

Character table
Mac character  =
Windows character

Picture table
bank pathname =
last picture number

LXRCONV.SET File Definition

Path table
default search location
for conversion tools
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which has a numbered position.  Different classes of fonts (e.g. True-
Type and  Bitmap)—can have a different displayed character for the
same character number.  The Groups Table instructs one of three gen-
eral Character Tables for the converter to use in making the transla-
tion.  TrueType fonts are designated to use the Standard TrueType
table.  Bitmap fonts are assigned to the Standard Bitmap table and
other special fonts are assigned to a StraightCopy table.  Fonts that
are not assigned to any Character Table  will default to using the Stan-
dard TrueType Character Table.

Character Tables [Standard TrueType/Standard Bitmap/ Straight-
Copy]    The three built-in character tables are used to assign a spe-
cific character (identified by its hexadecimal number) on the Mac to a
specific character on Windows.  Any character not listed in a table
assumes its same hexadecimal number position on Windows, so these
character tables only deal with exceptions where the character num-
ber is not the same on both Mac and Windows.  The converter can
translate a Mac character to a character in a different font by append-
ing “,fontname” to the Windows hexadecimal character number
(where fontname is the name of the Windows font).

Picture Table    The Picture Table stores the number of the last pic-
ture converted in each Windows bank (no effect on font conversion).  

Path Table    The Path Table stores the default path to locate third-
party graphic conversion tools (no effect on font conversion). 


